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Inside Information...

About The Information Alley

The Information Alley ™ is a
publication of Apple
Computer, Inc., Support
Information Services. It is
available to all Apple
customers and Apple
computer users through a
variety of on-line services and
direct email capability (see
Where to Find the

Information Alley on page 3).

The goal of the Information
Alley is to help Apple
computer users get full use of
their Apple computers,
peripherals, and software.

Articles chosen for the
Information Alley come from
many sources, both from
inside Apple Computer and
from our customers and users.
Sources include the Technical
Information Library, Apple
Assistance Center, New
Technology Group, World
Wide Product Technical
Support, Apple Users Groups,
and other technical groups
and organizations.

Submissions and Letters to the
Information Alley

We welcome articles that help
Apple computer users become
more knowledgeable about
the functionality of their
systems, explain or illustrate
complex features or
functions, or that describe
technical tips or techniques.
Send submissions to:

Information Alley

Apple Computer

1200 East Anderson Lane
MS 212-STI

Austin, TX 78752

Fax: (512) 908-8018
email: alley@apple.com

We also welcome letters to
the editor and suggestions
for future articles. Please send
all letters to the preceding
address.

Copyright Notice

This magazine and the
products and software
described in it are
copyrighted, with all rights
reserved.

Individual articles in this
magazine may be reprinted, in
their entirety, without prior
written permission from Apple
as long as full credit is given to
Apple Computer and the
Information Alley is listed as
the source of the information.

You must have prior written
permission from Apple
Computer to reprint portions of
articles from this magazine.
For permission, contact:

Janet Christian, Editor
Information Alley

Apple Computer

1200 East Anderson Lane
MS: 212-STI

Austin, Texas 78752

Voice: (512) 908-8975
Fax: (512) 908-8018
email: alley@apple.com

Trademarks

The Apple logo is a trademark of Apple
Computer, Inc., registered in the U.S.
and other countries.

Apple, the Apple logo, APDA,
AppleLink, AppleShare, AppleTalk,
AJ/UX, EtherTalk, HyperCard,
HyperTalk, ImageWriter, LaserWriter,

LocalTalk, Macintosh, and ProDOS are
trademarks of Apple Computer, Inc.,
registered in the U.S. and other
countries.

Apple Desktop Bus, Balloon Help, Disk
First Aid, Finder, SuperDrive,
Information Alley, and TrueType are
trademarks of Apple Computer, Inc.

Classic is a registered trademark
licensed to Apple Computer, Inc.

AppleCare is a service mark of Apple
Computer, Inc., registered in the U.S.
and other countries.

All other products mentioned in this
magazine are trademarks of their
respective companies.

Mention of third-party products is for
informational purposes only and
constitutes neither an endorsement nor a
recommendation. Apple assumes no
responsibility with regard to the
performance of these products.

Apple Computer, Inc., products
(hardware and software) described in
this magazine are subject to update and
change. This magazine makes no
assurance that functions and technical
information described here is not
superceded by subsequent releases of
the product described.

The Information Alley is produced using
FrameMaker 4.0 on a Macintosh Quadra
610 running System 7.

Published bi-weekly by

Apple Computer, Inc.
Support Information Services
1200 East Anderson Lane
MS: 212-STI
Austin, TX 78752
(512) 908-8975

Janet Christian, Editor

Regular Columnists:
Wayne Brissette
Janet Christian
Leslie Dolan
Stephanie Hahn
Mark Hansen
Fred Widmer

Z@ Please share when done!

© 1994 by Apple Computer, Inc.

Volume I, Issue 1

The Information Alley



Thoughts from the Alley Cat (Editor)

By Janet Christian

Why the Information
Alley?

The Information Alley is a
new publication of Apple
Computer, Inc., published bi-
weekly by Support Information
Services (SIS). The
Information Alley ’s goal is to
provide Apple computer users
with the technical knowledge
they need to use their Apple
computer systems to their
fullest potential.

To this end, we have scoured
every possible technical
source both inside and outside
Apple Computer. Our hope is
to give you the best of the best
in each issue.

We encourage feedback from
our readers. If you have a
technical topic you would like
to share with others, or if you
have an idea for an article,
please let us know. We want
the Information Alley to be a
forum for communication in as
many ways as possible.

Get Off the Highway

The Information Alley
sprouted from an idea by Jan
Costenbader, Manager of
Support Tools & Information,
and John Fenwick, Manager
of Support Information. They
nicknamed their idea “Get Off
The Highway”. Their idea was

Welcome to the
Information Alley

simple — sometimes the
information highway can get
clogged and information can
pass quite slowly. The more
“side roads” available, the
more likely you will get where
you want to go in a timely
manner. A source like the
Information Alley lets you “get
off the highway and onto the
side streets (or into the alley)”,
finding the information you
want in a convenient, local,
easy-to-use format.

Where to Find the
Information Alley

The Information Alley is
available through:

+ AppleLink

+  eWorld

«  CompuServe

« America Online

* Internet

Reprinting of Articles

We welcome reprints. Check
the inside cover page for
information about reprinting
whole or partial articles from
this publication.

Thanks to the Writers

| would like to thank those in
Support Information Services
and all the others who
provided the great articles for
this first issue. Many of them

are Apple veterans, with years
of experience on a variety of
products. This publication
would not be the quality it is
without their help.

Thanks to Alex Guidice

Many thanks to Alex Guidice,
who works in the PowerBook
Group of the Apple Assistance
Center for his hard work in
designing the official logo for
the Information Alley. Great
work, Alex — we were thrilled.

Let Us Hear From You

We want to hear from you
about the Information Alley.
Tell us what you think of the
articles and of the whole “look
and feel”. Please complete the
Tell Us What You Think form
on the following page and
return to the address, email, or
fax number indicated.

The Information Alley is here
to help you, so we want to be
as responsive to your needs
as possible.

If you have any questions
about the Information Alley,
please contact us at the
address, email address, or
phone numbers listed on the
previous page.

In the meantime, we hope you
find this magazine to be one of
your most useful and
informative tools. &
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New Technologies Notes

Text to Speech on AV Systems

By Howard Hudson

If you have an AV computer, you may want to
use its capabilities in processing speech and
sound. This article describes how to use your
computer to generate spoken documents from

T
&

typed ones.

An exciting
Technology
available in
the AV
machines is
Text-to-
speech.

Text-to-

command from the Edit menu and users can
direct an appropriately designed application to
change between voices in a body of text to
create a dialog effect.

Steps to Follow

Follow these steps to convert text to speech:

STEP ACTION

speech lets
text in

o ;,-»—v’j applications
~ be “spoken”

by the computer. Solutions for this technology
include proof reading without the user focusing
on the computer and storage of many hours of
“‘voice” (text takes up 1,000 times less space
than even the lowest quality digitized speech).

¥

The version of TeachText (7.2) on the hard drive
of the Quadra 840 AV and 660 AV and the
Centris 660 AV supports the PlainTalk Text-to-
Speech feature. Other applications may not yet
support this feature, but are expected to add it
in the future where it may be useful.

Speech Recognition, or, the ability of the
computer to respond to spoken commands,
does not need to be active, however the
PlainTalk Software, which includes the voices,
must be installed for this to work.

The Speech Manager
The Speech Manager lets users switch voices

within applications. Any selected text can be
spoken back by selecting the appropriate

1 Launch TeachText 7.2 and notice the Voices
sub-menu under the File menu. This lets you
change voices between spoken selections
without having to open the Speech Setup
Control Panel (the default voice is Female
Voice, Compressed).

2 Close the untitled window.

3 Open the Read Me document from the File
menu.

4 If no text is selected, you can issue the Speak
All menu command (38H) and the entire text
is read back. If you select a portion of text,
the menu changes to say Speak Selection
and just that is read back. Even though some
ReadMe files are not editable (so users don’t
change them) and therefore do not let
portions of text be selected, TeachText lets the
user select Speak All and have the contents
of the ReadMe spoken back. To stop speech
in the middle of speaking back, select Stop
Speaking from the File menu.

If your applications do not have an option for
Text-to-speech, you may want to check with the
application developer about plans to integrate
Text-to-speech into the application.

Howard Hudson is a Product Specialist in the
New Technologies Group. The NTG brings the
Apple Assistance Center up to speed on new
Apple products and technologies. &
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Using the SIMM Stack

By Mark Hansen

The SIMM Stack is a
HyperCard based stack which
contains visual and text based
information relating to memory
upgrade requirements,
specifications, and capabilities
of Apple Macintosh
computers and applicable
LaserWriter printers.

The stack is updated at major
product introductions.

Read On-line Services
Product Support
Information on page 8 to find
out about the on-line locations
where you can find the SIMM
Stack.

SIMM Stack 4.2.1* =————————PI=

The Macintosh/LaserWriter SIMM Stack

x Compact Macintosh w

Py
-

Sl
= Portable Macintoshw

w LaserWriters o

| Composite SIMM info|

This is the first screen of the HyperCard SIMM Stack. The
material is grouped according to product family. &
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From DOS to Mac and Back

By Janet Christian

If you are running on a Macintosh that includes
a DOS compatibility card (such as a Quadra
610 or Centris 610), you can easily switch
between the DOS and Macintosh operating
systems without disturbing the applications
running in either partition — there is no need to
restart each time or close active applications.

Once you set the PC Setup Control Panel to On
(and restart once to “activate” it), you switch
between operating systems by pressing the
“hot key” sequence defined in the PC Setup
window. The default sequence is $Return.

When you press $¥Return, your system
immediately switches from the current
operating system to the alternate operating
system. Your keyboard and mouse work with
the currently active operating system.

Note: Your mouse is only active in DOS if you
are running Windows 3.x (which includes
a mouse driver) or if you use a Microsoft-
compatible mouse driver. Two mouse
drivers found on most on-line services
that work properly are DRVR624.Z1IP
and MOUSE701.ZIP

Whether or not other peripherals attached to
your system work in DOS depends on your
particular system hardware configuration.

Copying Between Operating Systems

You can easily copy a variety of information
(such as text and graphics) between operating
systems. Read your Macintosh DOS

Continued on the next page...
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Compatibility Card User’s
Guide for a complete
description of the types of
information you can copy.

You can, for example, create a
graphic using a graphics tool
in one operating system, and
then copy and paste it into a
document in the other
operating system.

Using Separate Monitors

If you use separate monitors
for DOS and Macintosh, when
you press ¥Return while in
the Macintosh operating
system, your Macintosh
screen dims, active
applications continue
unaffected, and your DOS
monitor becomes active.

When you press ¥Return
again, your Macintosh screen
brightens and your keyboard
and mouse again interface
with the Macintosh monitor.
Your DOS screen does hot
dim and any DOS applications
you started continue running.

Using a Single Monitor

If you use a single monitor for
both operating systems, when
you press ¥Return your
current desktop (open folders,
active windows, etc.) is saved
and replaced by the desktop
you are switching to.

As with multiple monitors,
active applications continue
running even though you
cannot see them on your
desktop. When you switch
back, the saved desktop
redisplays, showing any new
information (such as a
completed process that you
began before switching). &

Gettin

the Most Out of Your
Color StyleWriter Pro

By Wayne Brissette
Paper Choice

The Color StyleWriter Pro
printer is the first color ink jet
printer offered by Apple for
home use. This printer can
provide you with vivid color
images. However, you may
not be getting the most out of
your Color StyleWriter Pro if
you use standard photocopier
or laser paper. Standard paper
absorbs the ink and the final
output looks a bit dull. But
there is a way to get much
brighter images from your
printer.

Use a special type of paper
designed for a color ink jet
printer. Most large paper
outlets carry this type of paper
in packages of 250 sheets.
You can also find smaller
packages at some of the
larger computer stores that
sell the Color StyleWriter Pro
or the Hewlett-Packard color
DeskWriter. The color ink jet
paper has one side coated
with a clay based substance
that doesn'’t let the paper
absorb the ink.

Print Dialog Box Settings

Paper Type

Select the Paper Type that
matches the type of paper you
use. The choices are: Plain,
Coated, Back Print, and
Transparencies.

Print Quality

There are three settings that
effect the output quality. Use
Best for the highest quality
output with little or no banding.

Use Normal for high quality
with some banding and
increased speed. Use Draft for
the greatest speed possible.

Halftone Options

The halftone options are
available by clicking on the
color button:

+ The Halftone option
determines how the printer
blends the four ink colors to
create different color
combinations.

+ The Pattern option works
well for charts and graphs.

« The Scatter option works
well for photographic
images.

ColorSync

The ColorSync software
makes colors look the way you
expect no matter what device
you use to view them —
Monitor, printer, or scanner.
After turning on ColorSync,
choose the option from the
pop-up menu that best
describes your document:

+ Photographic — for
complex picture with subtle
tones

+ Business Graphic —when
matching the vibrancy of
the color is more important
than matching the exact
hue

+ Spot Colors — when you'’re
using color calibrated
equipment

You may want to experiment
with these options to get the
best results. &

Volume I, Issue 1

The Information Alley




Looking for Something?

By Charlie McCabe

Where to Find Apple
Software Updates

Apple Software Updates include the latest free
versions of Apple software, including most
printer drivers, System Enablers, and updates
to communication, networking, and utilities
software. Customers should read the posted
Apple Software License Agreement
before downloading any software.

Currently, Apple’s Customer Service
Division (CSD) posts Apple software
updates to these on-line services:

+ AppleLink
+  eWorld

* Internet
AppleLink

Apple software updates are posted to
the APPLE SW UPDATES board
located in this path:

Internet — Apple Computer Higher
Education Gopher Server

Apple recommends using TurboGopher client
software to access the Apple Computer Higher
Education Gopher server. The USA Service,
Support & Training folder is located in this path:

HOME GOPHER SERVER
COMPUTER INFORMATION

APPLE COMPUTER HIGHER
EDUCATION GOPHER SERVER

APPLE SUPPORT AREA

APPLE SW UPDATES

Getting There From Here

TurboGopher Client software is
available via anonymous File Transfer
Protocol (using the ftp application) in
the /pub/gopher directory to:

boombox.micro.umn.edu

Using this Client software, you can
connect to the Apple Computer Higher
< Education Gopher server:

The host address is:
info.hed.apple.com
The IP number is:

APPLELINK SERVICES (MAIN WINDOW)
SOFTWARE SAMPLER
APPLE SW UPDATES

eWorld

Apple software updates are posted to the Apple
Software Updates board located in this path:

COMPUTER CENTER
APPLE CUSTOMER CENTER
APPLE SOFTWARE UPDATES

134.84.132.13

Where Else to Find
Apple Product Support

All Apple products purchased in the USA are
bundled with free “up and running” support for
as long as you own your Apple product.
Additionally, all hardware products (computers,
printers, and other peripherals) come with one
year free service, including any replacement
parts and labor.

Continued on next page...
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The telephone numbers listed
here are one point of access
for obtaining support or
service. Additionally, the
Technical Information Library
(TIL) is Apple’s official
technical support database,
with thousands of articles on
Apple products. The TIL is on
a variety of on-line services;
see the On-line Services
Product Support Information
section of this article for
further information.

On-line Services
Product Support
Information

Apple publishes basic “how to
contact Apple support”
information, Apple software
updates, the SIMM stack, the
Apple Technical Information
Library (Apple’s official
technical support database),
and other goodies to these
on-line services:

+ AppleLink

APPLELINK SERVICES
(MAIN WINDOW)

SUPPORT

+ eWorld

COMPUTER CENTER

APPLE CUSTOMER
CENTER

QUICK ANSWERS

* America Online

(Club Performa area — for
Macintosh Performa
owners only)

* Internet

+ Apple Tech Info Library

HOME GOPHER
SERVER

COMPUTER
INFORMATION

APPLE TECH INFO
LIBRARY

+ Apple software updates
and Apple support
information

See Internet — Apple
Computer Higher
Education Gopher
Server on page 7 for
the path and access
instructions.

GG-

Connecting to the
Home Gopher

?“E' Server
EE J] TheHome
s  Gopher Server
Vs IP number is:
134.84.132.4

The host address is:
consultant.micro.umn.edu

Use the TurboGopher Client
software to access this host.
Read Getting There From
Here on page 7 for more
information.

Watch the Information Alley
for additional Internet and
commercial on-line services.

Off-line Information
Sources

If you can’t find what you want
on-line, try one of these “off-
line” sources of information:

408-996-1010 — Apple
Corporate Telephone Number
(1 Infinite Loop, Cupertino, CA
95014)

800-SOS-APPL - “Up and
running” customer Technical
Support (Apple Assist. Center)

800-505-0171 — Apple Fax-on-
demand system (prior-to-
purchase information faxed
directly to you on any number
of Apple products.)

800-538-9696 — Apple
Referral Center (Resellers/
MUG/Trainer Locator)

800-365-3690 — Apple
Referral Center (for Newton
resellers) (extension 100)

800-776-2333 — CAC
(Customer Assistance
Center) (for pre-sales product
information)

800-769-2775 — Apple Order
Center (The Hibbert Group)
Order official Apple software
upgrade Kits, such as
HyperCard 2.2, System 7.1
Update Kit, System 7.1 on
800K disks, System 7.1
volume purchase, etc.)

800-950-2442 — AppleCare
orders (extension 200) For
ordering extended warranty
and service products

800-282-2732 — APDA USA
(Apple Prog. & Devel. Assn.)
To order Apple developer
information and tools.

408-974-4897 — Developer
Services (information on how
to become a registered Apple
developer)

408-974-4667 — Licensing
(Information on licensing
Apple software products for
distribution by third parties.)

408-974-7910 — Worldwide
Disability Solutions
(information for special needs
customers on using Apple and
2rd party products.). &
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System Software

The Why and How of a Clean Install

By Stephanie Hahn (7.1 clean install steps from
the Technical Information Library)

Why Do a Clean Install?

Most Macintosh computers come from the
factory with the system software installed on
the hard drive, and on the floppy disks, which
can be thought of as a “clean” version of the
system software. That is, the extensions,
control panels, fonts, System, Finder—in
essence, the entire contents of the System
Folder— come solely from Apple, and have not
been modified in any way. Because
the Macintosh is easily customized,
most users like to add Finder

enhancements, fonts, extensions
and such to their system to make it J e
more tailored for their own r,/
personal style. Sometimes these IL’

|
additions can cause
- __".::
L -T-"‘ "'"“‘-"‘\-L-_/‘..

incompatibilities, either Wlth
L F

another extension, or with that particular
version of system software. These
incompatibilities can cause the Macintosh to
hang, generate errors, or crash unexpectedly.
Another potential problem that may cause such
behavior might be actual corruption of a key
system component, such as the System, Finder
or an extension or font.

The most common incompatibilities occur when
users upgrade from an older version of System
Software to a newer version. Many times the
extensions or control panels that are already
installed in the System Folder need to be
upgraded to work with the newer version.
Installing “over” an existing System does not
remove or disable any incompatible System
Folder components. The Installer simply installs
over the existing System Folder, updating only
the Apple software; it leaves any third party
additions alone.

A Clean Install is a key trouble-shooting step

whenever your Macintosh is hanging, crashing,
or behaving “unusually”. To test for a potential
extension or control panel conflict is to restart
the Macintosh while holding down the Shift
key. This disables ALL extensions and any
control panels that load as a system extension.

If your Macintosh functions properly after
holding down the Shift key, then a clean install
should be your next step. If holding down the
Shift key doesn’t help, you might still have a
corrupted system component, and need to
cleanly install in any case.

How To Do a Clean Install

These steps

are for a
clean

install of
System 7.1 _
from -

[ % %

Step 1 — Restart with Disk Tools

Shut down your Macintosh, insert Disk Tools in
the floppy drive, and turn on the computer. At
the desktop, the Disk Tools floppy disk’s icon
should be in the upper-right corner of your
screen with your hard disk’s icon below it.

If the computer ejects the Disk Tools disk, make
sure you have an Apple SuperDrive (formerly
FDHD) that reads high-density disks. If your
computer doesn’t have a SuperDrive, you heed
System Software version 7.1 on 800K disks. To
getthe 7.0to 7.1 upgrade, call 1-800-769-2775.
(See your dealer for the upgrade from other
versions.)

If you have a Macintosh computer that requires
a System Enabler, you should use the Install
Me First disk that came with your computer.
The standard 7.1 Install disk doesn’t contain the

Continued on next page...
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Enabler, and won't start up a Macintosh that
requires one.

Step 2 — Run Disk First Aid

Run Disk First Aid to detect and repair
problems with a hard disk:

STEP ACTION

1 Open the Disk Tools disk, and double-click
on the Disk First Aid icon. In the window
that appears, be sure the main hard drive is
selected. If it isn't, click the Drive button to
select the main hard drive.

2 Click once on Open and then once on Start.

Disk First Aid checks your hard disk for any
potential problems. If it finds problems, you
should let the software repair them.

3 Repeat this procedure for each hard disk
attached to the system.

4 When you're finished verifying the hard
disks, choose Quit from the File menu to
return to the desktop.

If Disk First Aid can’t repair your hard disk, back
up the hard disk and re-initialize it using the
appropriate formatting utility for that drive. For
Apple drives, use Apple HD SC Setup.

Step 3 — Update Hard Disk Drivers

If you don’t have an Apple hard drive, or you
use third-party software to format your hard
disk, don’t use the Apple HD SC Setup utility.
However, you should contact your hard drive
vendor to verify that your formatting software is
compatible with system software version 7.1.

If you have an Apple hard drive, update the
drivers with the version of Apple HD SC Setup
that's on the Disk Tools disk:

STEP ACTION

1 Double-click the HD SC Setup icon on the
Disk Tools disk to open it.

2 Click on the Update button.

3 When finished, click Quit to return to the
desktop.

Sometimes HD SC Setup can'’t update the hard
disk driver (indicated by a “dimmed” Update
button). Here are some possible causes and
solutions:

+ If a third-party utility formatted your hard
disk, you should obtain the latest version
of the utility to update your hard drive.

« If a version of Apple HD SC Setup more
recent than the version on the Disk Tools
disk formatted your hard drive, don't
update the hard disk drivers.

« If an earlier System 6 version of Apple
HD SC Setup formatted the drive, it may
not have left enough room for the
updated driver. You don’t have to update
the hard disk drivers. However, if you
intend to use file sharing or have a
Macintosh that can use virtual memory,
then you need to back up the disk and
re-initialize it with HD SC Setup. This
erases the disk, so be certain you back
up the hard disk first.

+ If the driver is corrupt, the Macintosh
doesn’t recognize the drive (that is, the
drive doesn’t show on the desktop when
you start from a floppy disk). You may
wish to re-initialize it with HD SC Setup.
This erases the disk, so be certain you
back up the hard disk first.

Step 4 — Check Available Hard Disk Space

Be sure you have at least 5SMB available on the
hard disk where you plan to install the system
software. Open the hard disk’s window. Open
the Views control panel and select Show disk
info in header. The amount of available disk
space appears in the upper-right corner of any
open window.

If there’s less than 5MB available, you need to
delete unnecessary files by moving them to the
Trash. Choose Empty Trash from the Special
menu, to get more available disk space. (You
can copy files onto floppy disks or other media
before moving them to the Trash.)

Step 5 — Disable the System Folder
Disable the System Folder by moving the

Continued on next page...
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Finder and renaming the System Folder:

STEP ACTION
1 Open your hard disk's icon and locate the
System Folder.
2 Open the System Folder and locate the
Finder.
3 Create a new folder and name it Old Finder.

4 Move the Finder into this new folder.

5 Close the System Folder's window and
rename the System Folder Storage.

6 Close any open windows on your desktop.

Step 6 — Restart Your Computer

Choose Restart from the Special menu. The
system automatically ejects the Disk Tools disk,
and after a few seconds you should see a
picture of a disk with a flashing question mark.

If your Macintosh starts up from the hard drive,
you have an extra System Folder on the hard
disk. Delete or disable it, then restart.

When you see the flashing question mark on
your screen, you can continue. If you still don’t
see this on your screen, and you're installing
the system software on the internal hard disk,
turn off your Macintosh and all attached
peripherals. Then disconnect the SCSI cable
from the back of the Macintosh. Start your
Macintosh again.

Step 7 - Install System 7.1

Install system software version 7.1:

Step 8 — Verify Problem Resolution

After performing a clean installation, verify that
you resolved the problem before adding
anything to the new System Folder.

Step 9 — Install Non-Standard Items

You can now reinstall the non-standard items
from the old System Folder (which you named
Storage in Step 5) such as fonts, screen
savers, device drivers, and so on. (If possible,
reinstall these items from their original disks.)

If the original disks aren’t available, you may
move the non-standard items from the Storage
folder to the new System Folder. Be careful not
to replace anything that’s already in the new
System Folder. Only move items that aren’t
already in the new System Folder:

STEP ACTION

1 Open each corresponding folder within the
System Folder and the Storage folder and
then compare the contents.

2 Move anything that isn't already in the new
System Folder and its subfolders from the
Storage folder and its subfolders.

3 Restart your Macintosh.

STEP ACTION

1 When you see the flashing question mark,
insert the Install 1 or Install Me First disk into
the Macintosh. The computer starts up with
the system files on the Install disk.

Step 10 — Troubleshooting Extension Conflicts

If you've installed any system extensions or
control panels, you'll probably see their icons
line up across the bottom of the screen when
you restart. They load into memory at start-up
time and modify the standard behavior of the
operating system.

Step 11 — Verify Extension (INIT) Conflict

If the Macintosh fails to restart or behaves
erratically, you probably have an incompatible
or conflicting system extension or control panel.
Verify this problem:

2 Once the Welcome to the Apple Installer
message appears, click on OK.

STEP ACTION

1 Be sure the Caps Lock key is off.

3 Click on Install.

4 Insert the other disks when the Installer asks
you to.

2 Restart. After the smiling computer displays,
hold down the Shift key.

Continued on next page...
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STEP ACTION

STEP ACTION

3 Release the Shift key when the Welcome
to Macintosh, Extensions Off
message appears.

3 Close the System Folder, and restart the
Macintosh.

4 Attempt to recreate the problem.

4 When the Macintosh is ready, try to recreate
the erratic behavior.

5 Move one item from the new folder on the
desktop to the closed System Folder and
restart the Macintosh.

If the problem no longer occurs, you have a
conflicting extension or control panel. Continue
with Step 12.

Step 12 — Remove and Replace INITs in System
Folder

6 Attempt to recreate the original problem.

STEP ACTION

1 Create a new folder on the desktop.

2 Open the System Folder, Extensions folder,
and Control Panels folder, and choose by
Kind from the View menu.

Move all items of Kind “system extension” or
“control panel” to this new folder.

Repeat steps 5 and 6 for each item in the new
folder on the desktop until the problem recurs.
The last item returned to the System Folder is
probably the cause of the problem.

Step 13 — Final Steps

Verify that your applications are performing
normally. If not, refer to the application manual
or contact the vendor.

When the Macintosh behaves as expected, and
you are sure you have removed any necessary
items from the Storage folder, move the
Storage folder to the Trash, and choose Empty
Trash from the Special menu. &

VRAM Amounts and Color Choices

Memory (RAM) speed
«  SIMM SIZE

The SIMM size that can
be used.

By Wayne Brissette

The amount of Video RAM
(VRAM) you have in your
Macintosh computer
determines how many colors
you can use on your monitor.

Depending on what size
monitor you have, increasing
the amount of VRAM you have
installed, increases the
amount of colors on your
monitor. The VRAM chart on
the following page provides a
complete matrix of Macintosh
computers and their VRAM
requirements.

How to Read the Chart

The columns in the chart
include this information:

« MACINTOSH
The computer type
+ ON BOARD

The amount of VRAM
on the Logic board

+ VRAM SLOTS

The number of slots for
VRAM SIMMs

+  RAM SPEED

The Random Access

Using the Chart to
Calculate Maximum VRAM

You can easily use the
information in the VRAM chart
and the following formula to
determine the maximum
amount of VRAM you can
have in your particular system:

VRAM Slots x SIMM Size =
Maximum amount of VRAM
you can have.
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VRAM Chart

MACINTOSH ON BOARD | VRAM SLOTS RAM SPEED SIMM SIZE

Color Classic 256K 1 100 ns 256K

LC 0K 1 100 ns 256K or 512K

LCII 0K 1 100 ns 256K or 512K

LC I 512K 1 100 ns 256K or 512K

LC 475 0K 2 80 ns 256K or 512K

LC 520 512K 1 80 ns 256K

IIvx 0K 2 100 ns 256K or 512K

i 0K 2 100 ns 256K or 512K

Centris 610 512K 2 100 ns 256K

Centris 650 512K 2 80 ns 256K

Centris 660AV 1MB 0 80 ns 0

Quadra 605 0K 2 80 ns 256K or 512K

Quadra 610 512K 2 100 ns 256K

Quadra 650 512K 2 80 ns 256K

Quadra 660AV 1MB 0 80 ns 0

Quadra 700 512K 6 100 ns 256K2

Quadra 800 512K 2 80 ns 256K

Quadra 840AV 1MB 4 80 ns 256K

Quadra 900 1MB 4 80 ns 256K?2

Quadra 950 1MB 4 80 ns 256K2

Power Macintosh 6100/ 60! n/a n/a n/a n/a

Power Macintosh 7100/ 66! 1MB 4 80 ns 128K x 8 bit

Power Macintosh 8100/80! 2MB 4 80 ns 256K x 4 bit

Performa 400, 405, 410, 430 OK 1 100 ns 256K or 512K

Performa 450 512K 1 100 ns 256K or 512K

Performa 460, 466 512K 1 100 ns 256K or 512K

Performa 475, 476 0K 2 80 ns 256K or 512K

Performa 550 512K 1 80 ns 256K

Performa 600 0K 2 100 ns 256K or 512K
Notes:

! Power Macintosh models utilize DRAM based video, they are only expandable with the VRAM

Expansion Card installed. The Power Macintosh 6100/60 is not expandable.
2 VRAM SIMMs in the Quadra 700, Quadra 900, and Quadra 950 must be installed in pairs of two

SIMMs. &
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Power Macintosh

LAN Software Compatibility

Reprinted from the Technical
Information Library

This article details the Power
Macintosh compatibility of
these Apple client and server
software products:

+ AppleSearch
+ AppleShare family

+ Apple Remote Access
family

+ Apple Internet Router
+ A/UX

+ System 7 Pro/PowerShare
Collaboration Servers

For each product, there is
detailed information regarding
compatibility at introduction for
existing products, and revision
schedules and distribution
plans for Power Macintosh

Client Software
Compatibility Matrix on
page 17 summarize the
compatibility and upgrade
information.

Product Upgrade Strategies
AppleSearch

+ Compatibility as of Mar. 14

AppleSearch 1.0 server is
incompatible with Power
Macintosh at the March
14th Desktop Introduction.
AppleSearch Server 1.0
Demo Version on Trial CD
is also incompatible with
Power Macintosh. This is
because AppleSearch
Server 1.0 will only run on
68040-based Macintosh
computers and the Power
Macintosh 68000 emulator
reports itself as a

68020.

compatible upgrades. Some of
these revisions will coincide
with the PowerPC Server
introduction in May 1994.
Others will follow shortly
thereafter. The Apple LAN
Systems — Power Macintosh
Server Software
Compatibility Matrix on
page 16 and the Apple LAN
Systems — Power Macintosh

The AppleSearch
1.0 client,
running in
emulation mode,
is compatible
with Power
Macintosh on
March 14th.

+ Power Macintosh version

AppleSearch 1.0.1 Patch
will provide compatibility
with Power Macintosh.
Version 1.0.1 will be
available as a Patch which
can be installed over
AppleSearch 1.0. server
and will run in emulation
mode on the Power

Macintosh.

Version 1.0.1 will also run
on 68040-based Macintosh
computers, but there is no
need to upgrade since
there is no difference
between version 1.0 and
version 1.0.1 on 68040-
based systems.

AppleSearch 1.0.1 Patch
will be available in May
1994, and will contain two
versions — one for the
standard AppleSearch 1.0
server and one for the
AppleSearch Trial CD.

+ Upgrade distribution

AppleSearch Server 1.0.1
will be free and distributed
via a Patch which will be
posted on AppleLink, on
Apple’s Internet ftp server,
and on Service Provider’s
servers. AppleSearch 1.0.1
Patch will also be added to
the AppleSearch 1.0 kits for
new AppleSearch
purchases. The
AppleSearch Trial CD 1.0.1
Patch will always
accompany the
AppleSearch 1.0.1 Patch.

In the United States, the
AppleSearch 1.0.1 Patch
will also be available, for
free, directly from Apple at
1-800-SOS-APPL.

AppleShare
« Compatibility as of Mar. 14

AppleShare 3.0.3 is
incompatible with Power
Macintosh and is not
supported by Apple. Apple

Continued on next page...
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...Continued from previous page

recommends that all
customers wishing to run
AppleShare on Power
Macintosh upgrade to
AppleShare 4.0.2.

AppleShare 4.0 and 4.0.1
servers are incompatible
with Power Macintosh at
the March 14th Desktop
Introduction. This is
because AppleShare 4.0
and 4.0.1 servers will only
run on 68040-based
Macintosh computers and
the Power Macintosh
68000 emulator reports
itself as a 68020.

AppleShare Pro is
incompatible with Power
Macintosh since
AppleShare Pro only runs
on A/UX, and A/UX does
not run on Power
Macintosh.

The AppleShare
Workstation 3.5 (client
software) is compatible with
Power Macintosh on March
14th and ships with
System 7.1.2 (System 7 for
Power Macintosh). The
same version (3.5) will also
work as a client with Power
Macintosh-based
AppleShare servers
(description to follow).

Power Macintosh Version

AppleShare 4.0.2 will
provide compatibility with
Power Macintosh and will
be available in May 1994.
Version 4.0.2 will run on
both 68040 Macintosh and
Power Macintosh
computers and will runin
emulation mode on Power
Macintosh.

There are no differences

between AppleShare 4.0.1
and AppleShare 4.0.2 when
running on a 68040
Macintosh, so there is no
need to upgrade to 4.0.2 for
this environment.
Customers wishing to run
AppleShare on Power
Macintosh must upgrade to
version 4.0.2.

Upgrade Distribution

AppleShare 4.0.2 will be
available for a nominal fee
to all users of AppleShare
4.0 0r 4.0.1 and will be
distributed as an Update Kit
in the U.S. via a fulfillment
house only. This special
software kit contains the full
AppleShare 4.0.2 software,
but no manuals or serial
numbers. A valid
AppleShare 4 serial
number is required to order
the Update Kit.

Both the regular
AppleShare 4 software kit
and the AppleShare
Upgrade Kit (for customers
upgrading from
AppleShare 2 or
AppleShare 3) will be
revved to version 4.0.2 and
available through Apple’s
standard software
distribution channels.

Customers in the United
States and Pacific region
who buy a PowerPC Logic
Board upgrade to their
Apple Workgroup Server 60
or 80 will receive the
AppleShare 4.0.2 Update
Kit as part of the Logic
Board accessory Kit.

Apple Remote Access

Compatibility at introduction
AppleTalk Remote Access

1.0 Client and Server are
incompatible with Power
Macintosh.

The Apple Remote Access
2.0 Client and Personal
Server are compatible with
Power Macintosh running in
emulation mode.

The Apple Remote Access
MultiPort Server 2.0 is
incompatible with Power
Macintosh.

Power Macintosh Version

Apple Remote Access
MultiPort Server v.2.0.1 will
provide Power Macintosh
compatibility running in
emulation mode. Version
2.0.1 is expected to ship in
June 1994.

Upgrade Distribution

Apple Remote Access
MultiPort Server 2.0.1 will
be available to all users of
Apple Remote Access
MultiPort Server 2.0 as an
Update Kit via a fulfillment
house for a nominal
shipping and handling fee.
The update kits will modify
the Apple Remote Access
MultiPort Server software
only. No other changes are
necessary. A valid Apple
Remote Access MultiPort
Server serial number is
required to order the
MultiPort Server Update
Kit.

Owners of AppleTalk
Remote Access Client/
Server 1.0 wishing to run
this software on a Power
Macintosh must upgrade to
version 2.0. These
upgrades are available
through regular Apple

Continued on next page...
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software distribution
channels.

Apple Internet Router

Compatibility as of Mar. 14

Apple Internet Router 3.0
is incompatible with Power
Macintosh. The Apple
Internet Router 3.0.1 is
shipping now and is
compatible with Power
Macintosh running in
emulation mode.

Power Macintosh Version

Apple Internet Router 3.0.1

is currently available as
both a full kit for new
purchases and as a Tune-
Up to upgrade from version
3.0.

Upgrade Distribution

Apple Internet Router 3.0.1
is free to all users of Apple
Internet Router 3.0 and is
available as a Tune-up Kit.
The Tune-up kit provides a
patch which can be
installed over the Apple
Internet Router 3.0. The
Apple Internet Router 3.0.1
is available in the U.S.
directly from Apple at 1-
800-SOS-APPL, on

AppleLink, and on Apple’s
ftp servers. The regular
Apple Internet Router 3.0.1
Kits are available through
Apple’s normal software
distribution channels.

A/UX

Compatibility as of Mar. 14

A/UX is incompatible with
Power Macintosh.

Power Macintosh Version

Apple’s strategy is to
migrate A/UX server (Apple

Continued on next page...

Apple LAN Systems — Power Macintosh
Server Software Compatibility Matrix

COMPATIBLE DATE
PRODUCT VERSION UPGRADE METHOD AVAIL. PRICE

AppleSearch Server 1.0.1 Patch — On AppleLink, ftp servers, or 1- May 1994 | Free
800-SOS-APPL

AppleSearch Trial CD | 1.0.1 Patch — Delivered with AppleSearch 1.0.1 May 1994 | Free
Patch

AppleShare 3 Not Compatible | Upgrade to AppleShare 4.0.2 via May 1994 | $699.00
AppleShare Upgrade Kit, available
through dealer channel

AppleShare 4 4.0.2 AppleShare 4.0.2 Update Kit — through May 1994 | TBD
fulfillment house

AppleShare Pro Not Compatible | N/A N/A N/A

Apple Remote Access | 2.0.1 Apple Remote Access MultiPort Server June 1994 | TBD

MultiPort Server 2.0.1 Update Kit

Apple Remote Access | 2.0 N/A Now N/A

Personal Server

Apple Internet Router | 3.0.1 Upgrades from version 3.0 on AppleLink Now Free
and ftp servers — or call 1-800-50S-APPL

PowerShare 1.0 with Available on AppleLink, ftp servers, and TBD TBD

Collaboration PowerTalk dealer channels

Manager 1.0.2

A/UX Not Compatible | Distribution of upgrades from A/UX to TBD TBD

PowerOpen to be announced at a later date
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Workgroup Server 95)
customers to PowerOpen,
which is based on IBM'’s
AIX UNIX operating
system. PowerOpen
availability dates have not
yet been announced.

» Distribution

The distribution plan for
software upgrades from
A/UX to PowerOpen will be
announced at a later date.

System 7 Pro: PowerShare
Collaboration Servers

+  Compatibility at introduction

PowerShare Collaboration
Servers 1.0 and System 7
Pro (including PowerTalk)
are incompatible with
Power Macintosh at the
March 14th Desktop
Introduction. This is
because the PowerTalk
Manager needs to be
revised to work with Power

Macintosh.
Power Macintosh version

PowerTalk Manager 1.0.2is
required to use either
System 7 Pro or
PowerShare Collaboration
Servers on a Power
Macintosh computer. A new
Install Me First disk
containing the PowerTalk
Manager 1.0.2 will be
available at the time of
Power Macintosh
introduction.

Upgrade distribution

This disk is available from
the following electronic
bulletin board services:

The Safe House

DesignLink BBS

MacHaven BBS,

America Online

Connect Inc.

General Videotex Corp./
Delphi

Toronto Mac Developers
Association

John Crow

The Rest of Us,

Resource Central, Inc.
(Genie)

San Diego Macintosh User
Group

TwinCity Mac

Information Access
Technologies, Inc.

MacRefuge BBS

MAUG/Micronetworked
Apple (CompuServe)
Users

MauiLink

Netrunner BBS

North Start computer Ltd.

PressLink, Inc.

Deep Cove BBS

ZiffNet

Alaska Mac

Greyland BBS

Mac’s Place BBS

It is also available from
Apple user groups, the
Apple Volume License
program, and Apple
resellers. &

Apple LAN Systems — Power Macintosh
Client Software Compatibility Matrix

COMPATIBLE DATE
PRODUCT VERSION UPGRADE METHOD AVAIL. PRICE
AppleSearch Client 1.0 N/A Now N/A

AppleShare Client 35
(not sold stand-

Already ships with AppleShare 4.0/4.0.1, | Now Free
AppleShare Pro; will ship with System

Manager 1.0.2

alone) 7.1.2

AppleTalk Remote Not Compatible Upgrade to ARA 2.0 Client or Personal Now Client:

Access 1.0 Server, available through dealer channel $29.00
Pers. Svr:
$79.00

Apple Remote 2.0 N/A Now N/A

Access Client for

Macintosh

System 7 Pro System 7 Pro with | Available on AppleLink, ftp servers, and Now Free

PowerTalk dealer channel
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Tell Us What You Think

Tell us what you think of the Information Alley. We want the Information Alley to be as useful for you as possible. Your feedback
will help us reach this goal. Please fill out this form and fax, mail, or email it to the address at the bottom of this page.

Content

Were the articles interesting and informative? YES NO If NO, please explain:
How was the technical depth of the articles? NOT ENOUGH ABOUT RIGHT TOO MUCH
Comments:

Did you find any specific article especially useful? YES NO If YES, list which one:
Did you find any specific article impractical? YES NO If YES, list which one:
Format and Layout

Is the format and layout easy to follow? YES NO If NO, please explain:
Is the type easy to read? YES NO If NO, please explain:
Do the graphics enhance or clutter the magazine? ENHANCE CLUTTER
Comments:

Did you read the magazine on-line or did you print a copy? ON-LINE PRINTED COPY

Comments:

Please describe ways in which you feel the Information Alley could be improved, or give us your ideas on future articles.

Personal Information (optional)

Please let us know who you are in case we have questions about your suggestions or comments.

Name Telephone
Company Email

Address

City State Zip
Type of computer(s)

Primary software applications:

Information Alley, 1200 East Anderson Lane, MS

: 212-STI, Austin, TX 78752 — email: alley@apple.com fax: (512) 908-8018
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